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Mail Merge Overview 
 
Northwoods Mail Merge is a completely new version of our successful and popular Mail 
Merge Mania, which we first created for ACT! version 3. 
 
Note: In this document, when ACT! is used, we mean ACT! 2005, 2006 or 2007.  When 
we are talking about ACT! 6 or earlier, we use ACT! 6. 
 

Running Mail Merge 
 
You can run Northwoods Mail Merge from the Write menu in ACT!.  (This integration is 
not available in ACT! 6, but you can add your own custom menus.) 
 
Or, you run it from the Start Menu: 
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Setting up an Account 
 
Setting up an Account is the first thing to do.  The first time you Run Mail Merge, you 
will see the dialog: 
 

 
 
The Account Name will default to the last ACT! Username, or to “My Account” if that 
can’t be found. 
 
If you use Outlook 2003 or later, it is recommended you choose the “Copy Outlook Info” 
radio button.  The display is updated with the Outlook Accounts when you choose that 
option: 
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After you set up an Account, you will be take to the Accounts Tab.  If you chose the 
Copy Outlook Account option, you will need to set the SMTP password field. 

Accounts Tab 

 
 

SMTP server setup 
SMTP Server, SMTP Login Username and Password are required. 
 
From Name / Reply To 
The From Name, From Email are required.  The Reply To is required for using the 
Bounceback POP based handling. 
 
ACT Username / Password 
Required for doing mail merges to ACT!. 
 
My Field (MF_) Data 
Enter any “My Field” (like your name or phone number) for personalizing a template that 
is used by more than 1 person in your organization. 

Authentication 
Note that there is no setting for authentication.  Mail Merge supports Plain (no 
authorization), Auth Login (the most popular these days) and CRAM-MD5 
automatically.  Mail Merge connects to the SMTP server and then responds to the 
authorization mechanism that the server requests. (If you need the now-rarely-used POP 
login authorization, contact us.) 
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Templates Tab 
 

 
 
The Listbox shows the template files in the currently selected Template Folder.  The 
highlighted file is the “current template”.  Note that it shows the type as one of “html”, 
“html + text” or “text only”.    
 
If you create a file in the current Template Folder outside of MAIL MERGE, the listbox 
won’t be updated.  You can change the Template Folder to another location and then 
change it back, or you can just restart MAIL MERGE. 
 
Edit opens the selected template in the built-in HTML editor on the Edit Tab.  Double 
clicking in the listbox is a shortcut for Edit. 
 
There is currently no provision for editing Text templates, you must use Notepad and 
place the output in the Template Folder.  Note that the filename must be an exact match 
with HTML filename. 
 
Edit With (default HTML Editor) will open the selected template in the default HTML 
editor on this PC (provided one is installed).  Be sure to save the file before using it as a 
template in a mail merge.  (You can set the Default HTML Editor on your system with 
the Programs Tab of the Internet Explorer Tools > Internet Options Dialog.) 
 
The Template Folder dropdown gives you a choice of  multiple template folders. 
 
 
Duplicate will start the process of using an existing template to create a new one. 
 
Delete will delete the selected template. 
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New Template creates a new HTML file in the built-in editor. 
 
New from Stationery brings up the following dialog: 
 

 
 

After you pick the stationery and enter a name for the template to be created, the 
stationery file and all the pictures it needs will be copied to your template folder with the 
name you provide. 
 
(the OE stationery templates use the <Body Background=file.gif> HTML tag and 
browser-based email readers strip this out)  We hope to "fix" these templates 
automatically in a future release. 
 
The Get More Stationery... button takes you to the Microsoft Outlook Express 
Stationery download page.  There is a LOT of stuff here. 
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Template News / Preview panel 
On the right hand side of the Templates Tab is the CRMaddons News and Template 
Preview panel.  When you start up Mail Merge, the panel will show version information 
for Mail Merge, along with the latest news from the CRMaddons web site. 
 
By clicking on a template name on the Templates Listbox, a preview of the template will 
be show on the right.   You can hide the preview panel by clicking on the small button on 
the right hand side. 
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Edit Tab 

 
 
The HTML editor is a simple editor utility optimized for creating HTML that is good for 
sending in E-mail.  It has basic facilities for formatting (fonts, bold, italics, underline, text 
justification, indenting, and lists) as well as Tables and the use of tables for laying out the 
page. 
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HTML Editor Tool Bar 
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Merge Tab 

 
 
A “Merge” in MAIL MERGE is the process that uses a Template, a list of Contacts with 
associated fields, and an Account.   
 
The Template defines the content and format (html, text or both) of what is sent and the 
places Contact data is merged into that content. 
 
The Contacts can come from a variety of data sources, including ACT! and ACT! 6.  The 
method for choosing which Contacts are pulled from that source varies by data source 
type. 
 
The Account defines how the E-mail will be sent, as well as what “My Field” data is 
included in the content that is sent.  (My Field merging allows you to have one template 
that multiple people use, and they can merge in there own name and phone number, for 
example.) 
 
To begin, click Start Merge.  (You should select a template in the Template Tab first.) 
 
Once the contacts have been read, you can start sending email by clicking Send or 
Queue. 
 
The following controls are enabled after you have done Start Merge. 
 
Clear Send Flag clears the checkbox in the Send? Column for all the selected rows.   
 
Find Email… will search the Contacts list for a specific Email address. 
 
Attachments… Allows you to add attachments to the mail being sent.  (See the section 
on .CTL files for automatically associating a particular template with one or more 
attachments.) 
 
Save Sent Message Checking this box will cause Mail Merge to leave an on-disk record 
of the email that was sent.  This mail is saved in a folder named: 
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     My Documents\Northwoods Software\Mail Merge\Sent Email\2006-05\ 
 
Where the year and month at the end change over time.  The files themselves are named 
with the timestamp and email address of the contact: 
 
     05_10-06-18 AM_rgeary@gearlines.com.eml 
 
Note that these files are stored with a .EML extension.  The file is written in a “Standard” 
RFC-822  format.  Outlook Express can open these files.  Outlook can’t.  (We don’t use 
Outlook Express to send these files, you don’t even need to have OE installed unless you 
want to open the files and look at what you sent. We just archive them in a standard 
format that OE happens to support.)  (Outlook .msg files are a proprietary format that we 
haven’t figured out how to write or we would give you the option.) 
 
These .eml files are created as the email to the particular contact is being sent to the 
SMTP server.  They aren’t created (or needed) just to send the email if you don’t have the 
Save Sent Message checkbox checked.  Having this checkbox checked will slow down 
sending some, although in our experience it seems to be less than a 5% hit on the emails 
sent per minute. 
 
Create History  This checkbox enables the creation of a History record under the contact 
(all versions of ACT!). 
 
If Create History is enabled but Save Sent Message isn’t,  then there is no attachment of 
the sent message made under the History item.  But, if you enable both, then the .eml file 
created by Save Sent Message will be attached to the History Record. 
 
If you are running ACT! and you are using a “Shared” database, then the .eml attachment 
file is copied to the server system before being attached so that all users of the shared 
ACT! database can see the email.  If you delete the files created under My Documents, 
the attachments in the ACT! database will still be available to all. 
 
Send / Queue Once you have done the Start Merge operation, you have 2 choices about 
how to send the email. 
 
Send: The Send button will start the sending process using the data in the Contacts list.  
For each row in the list, if the “Send” Checkbox is checked and the “Sent Status” is 
blank, Mail Merge will generate a message with the merged fields and send an email to 
that email address.  Once the email has been handed off to the SMTP server, the Sent 
Status will be updated with the status from the SMTP send.  (Typically, this is “OK”). 
 
This is similar to Outlook or other email programs, where you can “watch” as the 
individual emails are sent out. 
 
Queue: When you press the Queue button, the state of the current merge will be bundled 
up in a package that can be sent asynchronously by a separate program included with 
Mail Merge.  (The separate sending program is the same one that our Sales Automation 
Manager uses to send daily emails.) 
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After pushing the Queue button, the Contact List will be cleared and the status line will 
be marked as (Queued). 
 

 
 
And, you will be given the option of stating the Queued Email sender immediately. 
 

 
 

See section Queued Packages for more detail on queued emails.
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Start Merge… 
 
When you click Start Merge… in the Merge Tab, you see the following dialog. 
 
 

 
 
The Start Merge dialog is where you pick the Account, Template and Contacts. 
 
The Account will be the account that is currently picked on the Account Tab, but you 
can change it here if you choose. 
 
The Template will be the currently selected file in the Template Tab. 
 
The settings for Source of Contact Data and Which Contacts are remembered from the 
last time you used this dialog. 
 
For ACT! 6, the only choice of Which Contacts is Current Lookup.   
 
NOTE: ACT!, Current Contact and Current Lookup choices use the database 
currently open in ACT!. 
 
For ACT!, we recommend you set up a Group in ACT! that specifies completely the list 
you want to send to.  (For example, set up a Newsletter Group that defines which contacts 
receive your newsletter).  If you do this, ACT! doesn’t even have to be running when you 
do the Merge. 
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ACT! Merge using Lookup 
 
You can do a “lookup” Merge on a single field 
 

• Equal to a value 
• Starts with 
• Field is empty 
• Field is non-empty 
 
Click on the  button to see the Define Contact Lookup dialog 
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ACT! Merge using Group 
 
Click on the  button to see the Choose Group dialog 
 
Select one group to do the Merge against. 
 

 
 
 

What Start Merge Does 
 
After you have selected the details of the Merge you want to perform, click OK.  MAIL 
MERGE will: 
 

1. Parse the Template 
2. Find the Merge Fields 
3. Open the Contact Source 
4. Read the Contacts into the Contacts List on the Merge Tab 
5. Check the Bounces list for any previous E-mail failure. 
6. Set the subject to what was found in the <TITLE> tag inside the HTML. 

 
You can edit data in the Contacts Lists (or add contacts at the end) before doing the Send. 
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Restarting an Interrupted Send 
If your system should crash or you lose power, Mail Merge can restart from the point it 
was at during a Send.  When you start Mail Merge, you will see this message: 
 

 
 

And if you do a Start Merge, you will see an additional choice in “Source of Contact 
Data”: 
 

 
 
Contacts in the contact list that were already sent to will be marked with Send Status of 
Done. 
 
If you want to delete this “incomplete send”, open My Documents\Northwoods 
Software\Mail Merge\Current Outbox and delete all the files there. 
 
Note that restartability is built in to the “Queue” process, so all you need to do is start the 
Queue Sender to restart an interrupted Queued Send. (See the Support Tab for Queue 
info.) 
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Bounces Tab 
 
Bounces happen when you send mail that can’t be delivered after it leaves your computer 
(in other words, after the SMTP server accepts the mail for delivery). 
 
The are lots of reasons for bounces…  
 

• “Hard Failures”  bad email address, mailbox full, mailbox no longer available … 
• “Soft Failures” unable to send, will keep retrying 
• “Challenges”  software that makes you do something before delivery 

 
More: http://en.wikipedia.org/wiki/Bounce_message
 
Hard failures take a million different forms, and they it is difficult to handle every last 
one.  Typically, they look something like this: 
 

 
 
 
Video start here: Mail Merge Bounces Tab Overview (Really rough... sorry about 
quality) 
 
The Bounces Tab handles “returned” emails (bounce backs, warnings, unsubscribes, 
some anti-Spam challenges, Out of Office messages and so on). 
 
Soft Errors are warnings such as “your mail hasn’t been delivered, we’ll keep trying” and 
“mailbox is over quota”.  Hard Errors are any that indicate the mail was undeliverable.   
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This list of E-mails is checked when a Merge is done, and any E-mails on this list are 
marked as “do not send” in the Contact List. 
 

 
 

Handling of Returns: method 1 (Easy) 
 
The easiest way of handling returns assumes you use Outlook 2003 or later.  (note: we 
haven’t tested with Outlook 2007 as of this writing.) 
 
When you send mail that generates a bounce back, it comes back to you as a mail 
message.  If you use Outlook, you can define a rule (or multiple rules) that will file most 
of these in a folder. 
 
The Outlook Rule we use to catch most bounces looks in the Subject line for one of: 
 

• Delivery fail 
• Undeliverable 
• Failure notice 
• Delivery Status Notification 
• returned mail 
• Undelivered Mail Returned 
• returning to sender 
• Delivery has failed 

 
And moves it to the bounces folder: 
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Once the bounces are all in this folder, you go to the Bounces Tab in Mail Merge. 

Handling of Returns: method 2 (no so easy) 
 
The way to setup up downloading of Bounces is a little tricky, but it works well. 
 
The advantages of this method is that it works if you don’t use Outlook.  Even if you do 
use Outlook, it keeps most of those bounce messages out of your Inbox, since they go to 
a separate e-mail address. 
 
The “From” E-mail Address in you Account needs to be just for receiving any bounce 
backs or errors returned.  SMTP servers tend to send errors back to the From Address. 
The “Reply To” Address in the account is the address you want people to send a real E-
Mail response.  The Account POP settings are used to locate and login to the mailbox. 
 
See the illustration. 
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Figure 1 - Using separate POP Account 

 

Processing Bounces: common to both methods 
On the bounces tab, there are 2 Download Bounceback buttons, one for Outlook and one 
for POP (methods 1 and 2 above).  Once the bounces are downloaded into the “Bounces 
Tab” for processing, the process is the same. 
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Figure 2  After the “Download Bounces” into Mail Merge 
 
When you click on Process… the automatic handling of returns and bounce backs is 
started.  All bounced messages that Mail Merge can read and understand are simply 
handled, the Bounces List updated and the message is deleted (you never see it). 
 
If any message isn’t understood, or is understood to be something important you should 
see, the automatic processing stops, and details of the message that can be discovered are 
displayed above the Process button in the Bounced Message Info region.  You are given 
3 choices for this message: Open, Skip or Delete  (see Figure 3  Bounce Processing 
stopped). 
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Figure 3  Bounce Processing stopped 
 
Open: The bounce message will be opened by Outlook Express (or whatever software on 
your system opens .EML files).  If it is a bounceback message that Mail Merge didn’t 
understand, you can add the email address to the Bounce List manually by clicking the 
Add… button.   Once you have handled the message, you can then Skip to Delete it. 
 
Skip:  The .eml file representing the bounce is moved to folder  
 

My Documents\Northwoods Software\Mail Merge\Bounces 
 

so that you can review it later.   If you are getting messages that you think Mail Merge 
should be able to process automatically, send the .eml files to Northwoods.  
(crmsupport@nwoods.com).    
 
Delete:  The bounce message is deleted. 
 
After a Skip or Delete, you can restart processing by clicking Process again. 
 
The Counts Region only shows the bounce processing counts for the current session.  It 
doesn’t track previous processing. 
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Exporting Bounces to ACT!  
 
(not supported for ACT! 6) 
 
When you click Export Bounces to ACT!, you get the dialog: 
 

 
 
You are then prompted for Export handling… 
 

 
 
We don’t recommend treating soft errors as a serious failure. 
 
Export Bounces then opens the database you have specified and looks for each contact by 
e-mail address.  If the contact is found, the appropriate fields have their values updated 
and the Remark column in Mail Merge is changed to “Updated in ACT!”.  (see Figure 4  
Exported Bounce Record). 
 

 25



Some emails in the Bounces list may not be found.  This can be for a variety of reasons.  
You may use multiple ACT! databases, so the contact may be in one and not the other (in 
this case, you can run “Export Bounces” for each database).   Your web site may send an 
email to people as soon as they fill in a form, but the contact may not get added to ACT!.  
(Our Web Prospect, for example, has some rules to try to avoid adding junk emails like 
ASDF@ASDF.COM to your database.) 
 

 
Figure 4  Exported Bounce Record 
 
The bounce records are never deleted automatically from Mail Merge.  After an Export, 
you can select the rows you want to remove and hit the Delete key, then click Save.  Or, 
you can just leave the records here.   (You can sort by clicking the Remark field if you 
just want to delete the rows that were Exported to ACT!.) 
 

Manual Bounce Handling 
You can just go to the Bounces Tab, Click Add… and enter an email address and click 
Save. You can also track unsubscribe requests this way. 
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ACT! Tab 
 
Not supported for ACT! 6. 
 

 

 
The ACT! Tab allows you to add a command to the ACT! Write Menu or Contact 
Toolbar that will launch Mail Merge and do a merge with a specific template to either the 
current contact or current lookup. 
 
In other words, Mail Merge pops up, does the Start Merge, and then is ready for you do 
click Send or Queue to start the sending of the email. 
 
Add button shows this dialog: 
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Support Tab  
 

 

 
The Support Page and Problem Report buttons open up appropriate pages on 
www.nwoods.com. 
 
Open Settings Folder will open the folder where your Account, Settings and Bounces 
(returns) data is stored. 
 
C:\Documents and Settings\USER\Application Data\Northwoods Software\MailMerge  
 
Documentation opens this file. 
 

Global Settings – To Name and Alternate Email Field 
Most settings are associated with Accounts, but 2 are global… for any merge with any 
account.   
 
The To Name field is the field pulled from the database to use as the “Name” associated 
with the “To” in the email. 
 
The Alternate Email Field lets you pick a field other than the standard Email Address 
field (this is just for use with ACT! merges).
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Creating Templates 
 

Merge Tags 
The “merge” part of “mail merge” involves merging data, typically from information 
about the person you are sending the mail to, into the email itself. 
 
Tags can be enclosed in {{curly brackets}} or [[square brackets]], but only use one type 
of brackets per file. 
 
For example: 
 
Dear {{First Name}}, 
 
For ACT! merges, you can use any contact field.  The Merge Field button in the HTML 
editor will help you insert merge fields into the document. 
 
There are also some special tags that will help you create even more useful merge 
templates. 
 

Subject Line 
 
Note that any of these special merge tags can also be used in the subject line when it is 
included in the <TITLE>Here is the subject line, {{First Name}}</TITLE> part of the 
HTML file. 

Date Tags 
 
To merge the current date & time information into an email, use the date merge tags. 
 

• {{ml_weekday}} 
• {{ml_month}} 
• {{ml_day}} 
• {{ml_year}} 
• {{ml_date}} 

 
{{ML_Weekday}} {{ML_Month}} {{ML_Day}}, {{ML_Year}} 
 
Will yield: 
 
Friday April 2, 2004 
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If these don’t give you what you want, we give you access to the full 
formatting power of the .NET runtime via 
 

• {{ml_date;format}} 
 
For example: 
 
{{ml_date;D}} 
 
Date Formatting can be used on any “Date” or “DateTime” contact field 
too. 
 
{{Create Date;d}}   

Date And Time Formatting Characters

format Description Default Format Example Output

d Short date mm/dd/yyyy 5/6/2001 

D Long date day, month dd, yyyy Sunday, May 06, 2001 

f Full date/short time day, month dd, yyyy hh:mm AM/PM Sunday, May 06, 2001 12:30 PM 

F Full date/full time day, month dd, yyyy HH:mm:ss 
AM/PM 

Sunday, May 06, 2001 12:30:54 
PM 

g Short date/short 
time 

mm/dd/yyyy HH:mm 6/5/2001 12:30 PM 

G Short date/long time mm/dd/yyyy hh:mm:ss 6/5/2001 12:30:54 PM 

M or m Month day month dd May 06 

R or r RFC1123 ddd, dd Month yyyy hh:mm:ss GMT Sun, 06 May 2001 12:30:54 GMT 

s Sortable  yyyy-mm-dd hh:mm:ss 2001-05-06T12:30:54 

t Short time hh:mm AM/PM 12:30 PM 

T Long time hh:mm:ss AM/PM 12:30:54 PM 

u Sortable (universal)  yyyy-mm-dd hh:mm:ss 2001-05-06 12:30:54Z 

U Sortable (universal)  day, month dd, yyyy hh:mm:ss 
AM/PM 

Sunday, May 06, 2001 12:30:54 
PM 

Y or y Year/month month, yyyy May, 2001 
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My Field Tags 
 
In older versions of MMM, the {{mf_First Name}} tag would pull the first name of the 
“My Record” record for the person doing the mail merge. 
 
MF tags in MAIL MERGE pull data from the My Field table in the Account record. 
 

 
 
For this account, MF_E-mail, MF_Contact and MF_First insertion fields could be used. 
 
Note that when Sales Automation Manager sends mail, it tries to use and Account Name 
that matches the Record Manager name for the Contact.  So, if “Joe Salesman” is the 
Record Manager for a contact, SAM will try to use a Mail Merge Account named Joe 
Salesman to send the email.  This allows you to personalize (using MF_ fields) a 
common template for more than one sales person. 

Company Tags 
 
For ACT! 2005 / 2006, which support the notion of a “Company” being associated with 
the contact, Mail Merge supports the use of {{Company_field}} tags.  If the contact has 
an associated Company, Mail Merge will go to that company record and pull the Field 
specified.  If there is no company associated with the contact, it just substitutes the empty 
string for the tag. 
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Conditional Tags 
 
Conditional tags allow some fancier formatting that isn’t available with simple 
substitution tags.  They allow inserting some piece of text into the merge based on the 
value of some contact field.  The conditional tags are: 
 

• {{if_blank;field;insert this}} 
• {{if_nonblank;field;insert this}} 

 
The most common use of this may be to do addressing an email to a single person or a 
couple. 
 
Dear {{First Name}}{{if_nonblank;Spouse First Name; and }}{{Spouse First Name}}, 
 
 
Will give you 
 

Dear John, 
 
Or 
 

Dear Bob and Shirley, 
 
depending on whether the field Spouse Field Name is blank. 

Dear Bob or Dear Sir/Madam 
 
Question: When I send an email I like to include the contact's name in the email. 
However some of our contacts do not have a name, just an email address. Is it possible to 
substitute blank contacts with a phrase such as 'Sir/Madam'? 
 
Answer:  Dear {{First Name}}{{if_blank;First Name;Sir/Madam}}, 
 

Prompting Dialog Tags 
 
Dialog tags provide a mechanism to prompt for merge data interactively when the merge 
is started.  The format is: 
 
{{DLG_Prompt;default value}} 
 
Or  
 
{{DLG_Price}}  with no default value. 
 
Example: 
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The prize for this week’s best endorsement is a free copy of 
{{DLG_ProductName;Mail Merge Mania}}. 

 
Will prompt: 
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Converting ACT! 6 .ADT templates 
ACT! supports one type of template called .ADT files.  There are edited using Microsoft 
Word.   Here is how to convert them for use with Mail Merge email: 
 

1. Open the .ADT file in Word 
2. In the Word Toolbar, click the "Show/Hide" backward P symbol. 
3. This may make visible a line that looks like this: 

 
DatbaseID=[[DatabaseID]]ContactID=[[ContactID]] 
 

4. Delete this line 
5. Do File > Save as Web Page 
6. In the Save As Dialog, pick "Save as type" of Web Page, Filtered 
7. Click Save. 

  
You will now have a .HTM file that should be compatible for use with Mail Merge. 
  
If there are"My Record" fields, like My:Contact, these will be treated as MF_Contact, 
and you will have to add a Contact under the MF_ fields on the Account Tab.  (Mail 
Merge doesn't read the ACT! My Record.)  
 
ACT! 6 ADT files use insert tags that look like [[Contact:26]].   Mail Merge supports the 
square brackets [[Contact]] and ignores the “field id” part (e.g. :26). 
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CTL files 
Control files (extension .CTL) allow you to define extra details for the template.  If you 
create a .CTL file in the same folder as the template, it will be included in the Start 
Merge. 
 
Example file names: 
 
  C:\templates\newsletter.htm 
  C:\templates/newsletter.ctl 
 
Currently, CTL files can be used to specify 2 things: Attachments and Subject.  (Subject 
can also be specified in the .htm <TITLE> tag, but this is the only way to specify a 
subject for a text-only template.) 
 
Format: 
 
Subject={{First Name}} – May Newsletter from Bob the Builder 
Attachment=c:\files\house1.pdf 
Attachment=c:\files\house2.pdf 
 

Queued Packages 
The “package” created by the Queue button on the Merge Tab really consists of 3 files. 
 

1. a .CTL file that contains the control parameters (template, subject, options, etc) 
2. a .XML file that contains the contact data and merge field data 
3. a .XSD file that is used by the system to read the .XML file 

 
These files are numbered starting with 1 (00001.ctl, 00001.xml, 00001.xsd), and they are 
stored in the folder: 
 

My Documents\Northwoods Software\Mail Merge\Email Outbox 
 
There is also one additional file created when that package is being sent that marks the 
record number of the last email sent (00001.restart) that will be used if the system crashes 
to restart sending at the proper place. 
 
When the Package is completed, these files are deleted by the Sender, and if more 
packages exist, the next will be opened and sending will continue. 
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Picture Considerations 
 
Outlook 2003 and later will block pictures by default.  So, mail that arrives looks like 
this: 
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This mail looks pretty good and is readable without the pictures.  If pictures are 
downloaded, the mail looks like: 
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However, it is possible to send mail that looks really awful if pictures aren’t seen by the 
reader.  Consider this example: 
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Which the sender intended to look like: 
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Or, this sample from Microsoft:  
 

 
 

 40



Which looks like this with pictures: 
 

 

Tips 
• Keep pictures small if possible. 
• Always use HTML that specifies the height and width of the pictures (this 

prevents the “right click here…” message from taking over the intended size and 
position of the picture). 

• Send yourself a copy of the mail in Outlook and see what it looks like. 
• Don’t get fancy (the Microsoft newsletter above uses a .GIF to do the bulleted 

lists instead of just using HTML lists).  (Also note that the Chart FX mail also 
does this for bulleted lists, but specifies the width and height and the result is 
much more readable.) 
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Character Encodings 
 

From Wikipedia, the free encyclopedia. 

A character encoding is a code that pairs a set of natural language characters (such as an 
alphabet or syllabary) with a set of something else, such as numbers or electrical pulses. 
Common examples include Morse code, which encodes letters of the Latin alphabet as 
series of long and short depressions of a telegraph key; and ASCII, which encodes letters, 
numerals, and other symbols as both integers and 7-bit binary versions of those integers. 

Mail Merge will read the character encoding from the HTML file during the merge 
process and then send the file with that encoding set in mail header. 

This has been tested with Windows-1252, koi8-r, gb3212, big5, iso-2022-jp and utf8... 
that's standard Windows, Russian, 2 Chinese, Japanese and Unicode). 

If you have trouble with characters not showing up correctly after being sent, please 
contact Northwoods Support and send us the template. 
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Integration with ACT! 2005 / 2006 / 2007 

Command Line 
The MAIL MERGE.exe program can be run with command line parameters to cause a 
Merge to be performed as soon as the program is run.  This is currently only supported 
for ACT!.  (For ACT! 6, see next section.) 
 
Using the command line in conjunction with ACT! integrated menu items and buttons, 
you can achieve a “one button click to send” integration between the two programs. 
 
Format: 
 

    <full path>Mail Merge.exe Template Lookup act7 Account History SaveSent 

 
P1 is the full path to the HTML file. (or .txt file) 
P2 is currentcontact or currentlookup 
P3 can be blank right now, but "act7" is recommended in case we add other datasources 
(use act7 for any version of ACT! 7, 8 or 9) 
P4 is Account Name - if blank, uses MAIL MERGE default account 
P5 is true/false to turn on off the "Create History" flag. (defaults to false) 
P6 is true/false to turn on/off the “Save Sent Message” flag. (defaults to false) 
 
Full example: 
 

C:\Program Files\Northwoods Software\Merge\Mail Merge.exe “C:\Documents and Settings\Jon 
Doe\My Documents\\Template\test.html” currentcontact act7 “Jon Doe” true 

 
Note that any parameter that has a space must be “quoted”.  This all has to be on one line. 
 
To integrate these into ACT!, the simple thing would be to use ACT!’s “Custom 
Command” feature.  But, alas, it doesn’t work with parameters. 
 
So, we’ve invented our own mechanism for adding menu items and buttons. 
 
Create a file called menusandbuttons.txt and place it in the same location as Mail 
Merge.exe.  This file can be used to define multiple menu items and / or button bar items. 
 

urn: act-ui://com.act/application/menu/write/Northwoods.SAM.1 
bar: Contact Detail Toolbar 
label: Run SAM 
tooltip: SAM is cool 
run: C:\Program Files\Northwoods Software\SAM\Northwoods.CRM.SAM.GOUI.exe 
icon: D:\Documents and Settings\Jake VanNoy\My Documents\Visual Studio 
Projects\NorthwoodsImages\Icons\ICO\All\SAM.ico 
 
urn: act-ui://com.act/application/menu/write/Northwoods.MailMerge.3 
run: C:\Program Files\Northwoods Software\Merge\Mail Merge.exe 
label: Merge Test to Current Lookup 
icon: D:\Documents and Settings\Jake VanNoy\My Documents\Visual Studio 
Projects\NorthwoodsImages\Icons\ICO\All\MMM.ico 
P1: D:\Documents and Settings\Jake VanNoy\My Documents\ACT\ACT for Win 7\Databases\Matt 
Pedro\Template\test.html 
P2: currentlookup 
P3: act7 
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P4: test all fields 
P5: true 
 

urn must be the first line of each menu/button.  blank lines are ignored 
 
urns must be unique.  Use act-ui://com.act/application/menu/write/ and append 
a unique name after that. 
 
Tooltip is optional, it will default to Label. 
 
Icon is optional for menu items. 
 
P1 to P7 optional, but are key to getting commands to run with the command line 
as described above. 
 
Using the example above results in this: 
 

 
 
 

Integration with ACT! 6 and earlier. 
 
The command line to run Mail Merge and start a merge with ACT! 6 is the same as in the 
previous section, with the exception that “act6” is used as P3. 
 
Format: 
 

    <full path>Mail Merge.exe Template Lookup act6 Account History SaveSent 

 
But, the way these are set up under ACT! 6 is different.  ACT! 6 can be set up to run 
Custom Commands with a single numeric parameter, like this: 
 

c:\runcommand.exe 2 
 

 
The program runcommand.exe will look for a file called "c:\runcommands.txt"  
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The file c:\runcommands.txt can have multiple lines and the ACT! custom command 
  

c:\runcommand.exe 4 
  
will run the 4th line in the file. 
  
You can download runcommand.exe from 
http://www.nwoods.com/act/kits/runcommand.zip (it isn’t included in the normal Mail 
Merge install kit).  Unzip it to C:\ 
 
After defining a runcommands.txt file, go to ACT! 6 and choose Tools > Customize 
Contacts Window…  and define a custom command. 
 

 
 
Then go to the Toolbars Tab, select Custom Commands Category and drag the 
custom command to the toolbar. 
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General Mail Sending Issues / SMTP Setup 
 

Internet / SMTP issues 

Port 25 Blocking 
 
If your company SMTP server is on the Internet (e.g. smtp.mycompany.com) then you 
access that server through IP Port 25. 
 
Many ISPs (especially on dialup lines) block Port 25, which is the port used to send mail 
through an SMTP server.  If your ISP does this, then you will have to use the ISP 
provided SMTP server.  (In other words, you won’t be able to use an SMTP server 
running on your local system, or an SMTP server somewhere else on the Internet.) 
 
These major ISP's block Port 25: 
 
• NetZero 
• Mindspring 
• MSN 
• Earthlink  
• Flashnet  
• MediaOne 
• AT&T 
• Verizon 
 
A lot of the smaller ISPs are blocking port 25 now too. 
 
If you click “Test SMTP Settings” on the Account tab of MMM, and the connection to 
the SMTP server listed in that account fails, we will run a test to connect to an SMTP 
server on the Internet.  If that test fails, either your Internet link is down or it is likely 
your ISP is blocking port 25 OR your Norton, McAfee or other firewall is blocking 
Mail Merge from accessing the Internet. 
 

Running your Own SMTP Server 
 
Some Merge tools will advertise “super fast – includes its own SMTP server”.  There are 
several problems with this.   
 
First of all, the send is fast, but it has really just copied the emails from the merge tool to 
files on your hard drive – that’s where SMTP servers hold the email that is in their queue.  
(like the magician that uses sleight of hand to hide the balls and stuff them in his 
pocket…. he still has the balls.)  The SMTP server then has to connect to multiple remote 
SMTP servers to deliver the email.  Your computer has to lookup each server it is 
sending to, connect to it and pass the mail along, as opposed to the case where you use 
your ISP’s SMTP server, where one connection is made and all the mail is sent to one 
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place.  (Consider this: would you rather make 1 phone call and say “hello” 250 times or 
make 250 phone calls and say “hello” once to each?) 
 
Second, if your ISP does Internet / SMTP issues 

Port 25 Blocking 
, this won't work, as SMTP servers use Port 25 to communicate. 
 
And finally, there is a good chance that mail you send from your own PC will have a 
"header" when it gets to the destination that says something like  
 
X-SPAM-Tagged: The server pool-64-222-122-355.man.east.verizon.net 
[64.222.122.355] that sent this message is listed on 
dul.dnsbl.sorbs.net. (http://www.dnsbl.us.sorbs.net/DUL-FAQ.html) 
 
You will probably find that your DSL or Cable access line is listed in this SORBS list.   
 
If you still want to run your own SMTP server, we recommend that you can get a copy of 
Postcast SMTP Server (around $29) from www.postcastserver.com.  It is a very good 
product.  Windows XP also has a built in SMTP service, but we've never had much luck 
with it.  
 

Commercial SMTP Services 
 
While we have no experience with these services, both www.smtp.com and 
www.authsmtp.com offer SMTP service for what appear to be reasonable rates.  
 
If you use one of these (or other SMTP services), please let us know about your 
experience. 
 

What Northwoods Does to send mail 
 
It's getting very hard to send lots of emails these days.  We host nwoods.com and 
crmaddons.com at Peer1, and we used to be able to send 1000s of emails with MM 
without problems. 
 
However, the most recent email to our 25,000 Freebee Newsletter list was getting 
frequent hang ups.  When we called Peer1, they told us that the terms of our contract say 
we can send 25 emails at a time.  This isn’t something that they ever enforced before, but 
now they seem to be. 
 
We ended up buying a dedicated mail server system at Interland/Peer1.  We're paying 
$200 / month for it.  It is a wonderful thing to be able to control your own hosted SMTP 
server.  But we realize this isn’t for everyone. 
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Mail Merge can be set up to send a "burst" of messages, then log out and wait for a 
period before continuing.  This remains the best method for sending a moderate amount 
of messages through your own ISPs SMTP server. 
 
And keeping your list "clean" from bounce backs (bad email address) will help too.  
SMTP servers count bounce backs / bad email domains and will hang up on you if you 
have too many.  Some SMTP servers (like AOL.COM) count how many bad email 
addresses you send to at that domain… and if you send too many emails to “non-
existent” email addresses, that particular server will stop accepting mail from you. 
 
 

Bounce Back Handling 
 
When you send an email to an SMTP server, the fact that the SMTP server accepted the 
email isn’t a guarantee that it can deliver it.  Your SMTP server makes connection to the 
“To” address server sometime after you send the mail.  (For a good visual explanation, 
see http://computer.howstuffworks.com/email5.htm) It is at that point that your SMTP 
server can get an error trying to send the mail.  The errors can be: 
 

• That domain doesn’t exist 
• No mailbox with that name 
• Mailbox is over quota 
• Server not available, will keep trying 
• Target server detects spam/images/other content it doesn’t like 
• And so on… 

 
It’s also possible that your SMTP server will be successful in passing the mail along, and 
that the error will happen on a later attempt to relay the email. 
 
There are also other auto-generated replies from the actual recipient of the email: 
 

• I’m out of the office / on vacation 
• I’m using a new email address 
• I’m using a Spam Block Tool, please… 
• I don’t accept email in HTML format 
• I got your mail, and I’ll certainly read it sometime… 

 
As a mailing list ages, the number of invalid addresses in that list increases.  This causes 
a couple of problems.  First, you can a lot of “bounce back” messages from the SMTP 
server, and simply dealing with them can take much longer than creating the template and 
sending the original mail merge. 
 
Second, and a potentially more serious issue, is that sending mail to enough invalid 
addresses can cause your SMTP server to hang up on you.  This is a part of the “how do I 
avoid being considered a spammer when I’m really just a legitimate small business” 
question.  Keeping your list clean is critical. 
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For these reasons, we have implemented bounce back support in Mail Merge.   
 
SMTP Error Messages: http://email.about.com/cs/standards/a/smtp_error_code.htm
SMTP Inside Out: http://email.about.com/cs/standards/a/smtp.htm

Tracking who reads your E-mail 
 
A common question we get is “how do I know how many people (or who specifically) 
read my email”?  Can I do reporting like this? 
 
Tracking email reading is done with a “hack”.  A small picture is placed in your email, 
and the http: references to that picture can be monitored.  These images are called “web 
beacons” or “web bugs”.  E.g.: http://www.mydomain.com/tracking/beacon123.gif
 
What happens is when the user reads your email, the email client will request all the 
images to display the email.  The beacon123.gif request will be noted by your web server, 
and by scanning the web server log of files requested, you can find out the IP address of 
the reader of the email.  (or, you can put a unique number in each .gif name and know 
who read the mail.) 
 
A better explanation is here: http://en.wikipedia.org/wiki/Web_bug
 
Web based email packages have an advantage here, in that they can add the web bug to 
your email to track.  And since they are web based, they can track a reference to a beacon 
reference back to their site. 
 
But… as the wiki page notes, most email clients now don’t display the pictures by 
default, so the reference to the beacon is never made. 
 
So, what you end up with is this 
 

user read mail & 
beacon

read mail with 
no graphics

never opened 
email

spam filter ate 
the email
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You will know how many people read the email, had graphics enabled and referenced the 
beacon (the blue area).  But there is no way to know the break down of the other 3 
possible results.   
 
Our question to you about all this is this:  so, you send 100 emails and you know 20 
people read the email in the next 24 hours.   What are you going to do with that info 
now?  What good is it? 
 
The real measure is how many people respond to the email, or how many sales you get.  
And you already know how to measure that, right? 
 

General Release Notes 
 

Notes for old Mail Merge Mania users 
 
The old {{ML_Subject=Subject}} tag has been deprecated in favor of the use of the 
<TITLE>Subject</TITLE> HTML tag.  If you want a quick way to update old templates, 
download http://www.nwoods.com/act/kits/FixSubject.zip and run that program. 

Templates 
 

• On startup, if MAIL MERGE finds an existing MMM template folder, it will use 
that. 
 
If there is no MMM folder, it will use 
 
  My Documents\Northwoods Software\Mail Merge\Template\ 
 
You can change the Template folder and it will remember this. 
 

Accounts 
 

• You can't rename Accounts (yet). 
 

CSV & Excel Merge 
 

• Use simple file names like "abc.csv", not "Contacts - Merge 2004-10-20.csv". 
 

• There is no duplicate check with CSV and Excel (yet). 
 

• Add Note not supported (obviously). 
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HTML Editor 
 

• We hope to add some support for FTPing images to an http: address in a future 
release. 

Merge 
 

• MF_fields or My: fields do NOT go to the ACT! database, they use the data 
within the Account being used.   {{MF_First Name}} pulls the "First Name" field 
from the "My Field" table within the Account used in the Merge. 

 
• There is no "Text Only Domains" like MMM had. 

 
"Find Email" button on Merge page only works when list is sorted in "msg id" order. 
 

End of MAIL MERGE User’s Guide. 
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Addendum: Faxing with Mail Merge 
Fax support has been added “experimentally” to Mail Merge 9.7.  In fact, faxing has been 
supported in our Sales Automation Manager since we first supported ACT! 2005. But 
until now, there has never been a way to do an interactive Start Merge with Mail Merge 
and have it send a fax. 
 
Fax support right now is conditional on a positive beta test.  We may improve it or rip it 
our in future versions, there is no promise either way.  And we may only support it for 
ACT! 9  and later.  Tested only with Word 2003. 
 
Fax support currently only supports Microsoft Fax that is included with Windows XP.  It 
is a conditional part of the Windows installation.  You can add it to your system by going 
to the Control Panel, choosing “Add or Remove Programs” and then choosing 
Add/Remove Windows Components.  Make sure Fax Services is installed. 
 

 
 
Further setup can be done in Control Panel Phone and Modem Options, where you can 
specify dialing rules and under the Windows Start > Programs > Accessories > 
Communications > Fax > Fax Console application. 
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Faxing is done with Word templates, set up with special Merge fields, this video will 
show you how to do that: 
 
http://www.crmaddons.com/media/videos.asp?product=crmsam&play=sam2005-
WordInsertField.asx 
 
There's no audio with this video, unlike most of our videos.  Note that ACT! fields with a 
blank must have an underscore in the Word Merge field, since Word doesn’t support 
blanks in field names.   (You DON’T have to change the ACT! field names.) 
 
Also see the sample template at the end of this section. 
 
If you also install our SAM product, you will find some Word / fax template samples in 
the My Documents\Northwoods Software\Sales Automation Manager\Template folder. 
 
Once the .DOC template is set up, you need to also set up a companion control file.  For 
abc.doc, you need a file called abc.ctl in the same folder. 
 
Edit the .ctl file with Notepad: 
 

 
 
You will need 1 Field= like for each merge field you want the Start Merge to pull from 
ACT!.  The required FaxColum= line tells Mail Merge which field is the fax number.   
Subject=, FaxCovernote= and FaxCoverpage= are all optional. 
 
Note that the Field= names must match the ACT! field names exactly, but the 
FaxColumn= will have an underscore in the place of blanks (Fax_Phone).  
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Once the .doc and .ctl files are prepared, you can go to Mail merge. You choose "Fax 
templates" radio button on the Template Tab. 
 
Make sure the Types column says “fax + ctl” 
 

 
 
Choose a .doc file, then go to the Merge Tab 
 
Do "Start Merge", pick a contact lookup and click OK.  (we’ve tested ACT! and ACT! 6, 
but not CSV and Excel.  Note ACT! 6 uses “Fax” and not “Fax Phone” for the fax field.) 
 
The Start Merge will load the contact list inside MM Merge tab. 
 
Then, to start the fax, click "QUEUE".... (Note Send doesn't work.... just QUEUE) 
 
A separate little window should start up and will start sending faxes to MS FAX, and the 
faxes will start to show up in the MS Fax Console.  You will also see Word popping up 
on the screen as each separate fax file is prepared. 
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Sample Fax Template: 
 
«Company» 
«Contact» 
«City», «State» 
 
Subject: How to create templates for Letters, Faxes, and Generic Letters
 
Dear «First_Name»: 
 
This is a sample letter template that can be merged and printed using Sales Autom
Manager for ACT 2006/7/8/9.   
 
Note that the substitution tags used here are just “standard” Microsoft Word mai
(right-click and then click Edit to view properties).   
 
Instructions for adding merge tags for ACT fields: 
 
To add a new merge tag the “easy way”: 
1. Create your own letter by starting with this template. 
2. Copy and then paste an existing tag, such as <<First_Name>> above. 
3. Right-click the copied tag and then click Edit Field. 
4. Change the name of the field in the Field Name box to the name of the ACT!

REALLY want to substitute in.  
NOTE: you must type the field name EXACTLY as it appears in ACT under “Tools… Define
including capitalization and spacing – NOT as it appears on your ACT layout, which can some

5. Then, if the ACT field has any spaces in it, further edit the Field Name as fol
replace each internal space character in the field name with an underscore (tha
merge requirement).  That is why ACT’s “First Name” field appearing above
entered as First_Name. 

 
Word Templates Like This are Needed for both FAXes and Letters 
 
SAM uses Word templates for Letters and Faxes, and HTML templates for email
you want to send a Generic Letter (see SAM User Guide) using a template name
should have two templates in your Template folder: XYZ.htm and XYZ.doc (a W
 
 
Thanks much, 
Northwoods Software 
 
P.S. Unlike Word templates, HTML templates use “squiggly brackets” (correctly 
“braces”) as substitution tags and must not have the underscore, for example: {{Fi
 

 

 

 

This is a sample Word
template that can be 
used to send a FAX or 
Letter with Sales 
Automation Manager.
ation 

l merge tags 

 field you 

 Fields” – 
times be different.   
lows:  
t is a Word-
 is actually 

s.  Therefore, if 
d XYZ, you 

ord template).  

known as 
rst Name}}. 
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